
Multi-purpose Production Calculator by Cid / hvor er jeg

Released: November 2023 0 0 0 0 0 0

Commercial Total § 0 Neosims § Last Collection Time:

Regional Total § 0         Neosims § Max Collection Total:

Seasonal Total § 0 0 0 0 0 0 0 0 0 0 0 0

Grand Total § 0

Commercial Shops Materials Required Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Building Supplies Store
0 Nails 80 0 4 0.0 0.0 0.00 0.00 0 2 0 0 15.0 30.0 60.0 180.0

0 Planks 120 0 24 0.0 0.0 0.0 0.00 0 2 0 0 2.5 5.0 10.0 30.0

0 Bricks 190 0 16 0.0 0.0 0.0 0.00 0 2 0 0 3.8 7.5 15.0 45.0

0 Cement 440 0 40 0.0 0.0 0.0 0.00 0 2 0 1 0 1.5 3.0 6.0 18.0

0 Glue 440 0 48 0.0 0.0 0.0 0.00 0 1 0 2 0 1.3 2.5 5.0 15.0

0 Paint 320 0 48 0.0 0.0 0.0 0.00 0 2 0 1 0 2 1.3 2.5 5.0 15.0

Cost to open all slots: 252 Total 0 Total 0.0 0.0 0.0 0.00

Hardware Store
0 Hammer 90 0 11.2 0.0 0.0 0.00 0.00 0 1 0 1 0 5.4 10.7 21.4 64.3

0 Measuring Tape 110 0 16 0.0 0.0 0.0 0.00 0 1 0 1 0 3.8 7.5 15.0 45.0

0 Shovel 150 0 24 0.0 0.0 0.0 0.00 0 1 0 1 0 1 2.5 5.0 10.0 30.0

0 Cooking Utensils 250 0 36 0.0 0.0 0.0 0.00 0 2 0 2 0 2 1.7 3.3 6.7 20.0

Ladder 420 0 48 0.0 0.0 0.0 0.00 0 2 0 2 0 1.3 2.5 5.0 15.0

0 Drill 590 0 96 0.0 0.0 0.0 0.00 0 2 0 2 0 1 0.6 1.3 2.5 7.5

Cost to open all slots: 252 Total 0 Total 0.0 0.0 0.0 0.00

Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Farmer's Market
0 Beef 860 0 120 0.0 0.0 0.0 0.00 0 3 0 0 0.5 1.0 2.0 6.0

0 Vegetables 160 0 16 0.0 0.0 0.0 0.00 0 2 0 0 3.8 7.5 15.0 45.0

0 Flour Bag 570 0 24 0.0 0.0 0.0 0.00 0 2 0 2 0 2.5 5.0 10.0 30.0

0 Fruit 730 0 72 0.0 0.0 0.0 0.00 0 2 0 1 0 0.8 1.7 3.3 10.0

0 Cream 440 0 60 0.0 0.0 0.0 0.00 0 1 0 0 1.0 2.0 4.0 12.0

0 Corn 280 0 48 0.0 0.0 0.0 0.00 0 1 0 4 0 1.3 2.5 5.0 15.0

0 Cheese 660 0 84 0.0 0.0 0.0 0.00 0 2 0 0 0.7 1.4 2.9 8.6

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Furniture Store
Chairs 300 0 16 0.0 0.0 0.0 0.00 0 2 0 1 0 1 3.8 7.5 15.0 45.0

Tables 500 0 24 0.0 0.0 0.0 0.00 0 1 0 2 0 1 2.5 5.0 10.0 30.0

0 Home Textiles 610 0 60 0.0 0.0 0.0 0.00 0 2 0 1 0 1.0 2.0 4.0 12.0

Cupboard 900 0 36 0.0 0.0 0.0 0.00 0 2 0 2 0 1 1.7 3.3 6.7 20.0

Couch 1810 0 120 0.0 0.0 0.0 0.00 0 3 0 1 0 1 0.5 1.0 2.0 6.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Gardening Supplies
Grass 310 0 24 0.0 0.0 0.0 0.00 0 1 0 1 0 2.5 5.0 10.0 30.0

0 Tree Saplings 420 0 72 0.0 0.0 0.0 0.00 0 2 0 1 0 0.8 1.7 3.3 10.0

Garden Furniture 820 0 108 0.0 0.0 0.0 0.00 0 2 0 2 0 2 0.6 1.1 2.2 6.7

Fire Pit 1740 0 192 0.0 0.0 0.0 0.00 0 2 0 1 0 2 0.3 0.6 1.3 3.8

Lawn Mower 840 0 96 0.0 0.0 0.0 0.00 0 3 0 1 0 1 0.6 1.3 2.5 7.5

Garden Gnomes 1600 0 72 0.0 0.0 0.0 0.00 0 2 0 1 0 0.8 1.7 3.3 10.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Donut Shop
Donuts 950 0 36 0.0 0.0 0.0 0.00 0 1 0 1 0 1.7 3.3 6.7 20.0

Green Smoothie 1150 0 24 0.0 0.0 0.0 0.00 0 1 0 1 0 2.5 5.0 10.0 30.0

0 Bread Roll 1840 0 48 0.0 0.0 0.0 0.00 0 2 0 1 0 1.3 2.5 5.0 15.0

Cherry Cheesecake 2240 0 72 0.0 0.0 0.0 0.00 0 1 0 1 0 1 0.8 1.7 3.3 10.0

Frozen Yogurt 1750 0 192 0.0 0.0 0.0 0.00 0 1 0 1 0 1 0.3 0.6 1.3 3.8

Coffee 750 0 48 0.0 0.0 0.0 0.00 0 1 0 2 0 1 1.3 2.5 5.0 15.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Fashion Store



Cap 600 0 48 0.0 0.0 0.0 0.00 0 2 0 1 0 1.3 2.5 5.0 15.0

Shoes 980 0 60 0.0 0.0 0.0 0.00 0 2 0 1 0 1 1.0 2.0 4.0 12.0

Watch 580 0 72 0.0 0.0 0.0 0.00 0 2 0 1 0 1 0.8 1.7 3.3 10.0

Business Suits 1170 0 168 0.0 0.0 0.0 0.00 0 3 0 1 0 1 0.4 0.7 1.4 4.3

Backpack 430 0 120 0.0 0.0 0.0 0.00 0 2 0 2 0 1 0.5 1.0 2.0 6.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Fast Food Restaurant
Ice Cream Sandwich 2560 0 11.2 0.0 0.0 0.00 0.00 0 1 0 1 0 5.4 10.7 21.4 64.3

Pizza 2560 0 19.2 0.0 0.0 0.0 0.00 0 1 0 1 0 1 3.1 6.3 12.5 37.5

Burgers 3620 0 28 0.0 0.0 0.0 0.00 0 1 0 1 0 1 2.1 4.3 8.6 25.7

Cheese Fries 1050 0 16 0.0 0.0 0.0 0.00 0 1 0 1 0 3.8 7.5 15.0 45.0

Lemonade Bottle 1690 0 48 0.0 0.0 0.0 0.00 0 2 0 2 0 1 1.3 2.5 5.0 15.0

Popcorn 1250 0 24 0.0 0.0 0.0 0.00 0 1 0 2 0 2.5 5.0 10.0 30.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Home Appliances
0 BBQ Grill 530 0 148 0.0 0.0 0.0 0.00 0 3 0 1 0 0.4 0.8 1.6 4.9

Refrigerator 1060 0 189 0.0 0.0 0.0 0.00 0 2 0 2 0 2 0.3 0.6 1.3 3.8

Lighting System 890 0 94 0.0 0.0 0.0 0.00 0 1 0 1 0 1 0.6 1.3 2.6 7.7

TV 1280 0 135 0.0 0.0 0.0 0.00 0 2 0 2 0 2 0.4 0.9 1.8 5.3

0 Microwave Oven 480 0 108 0.0 0.0 0.0 0.00 0 4 0 1 0 1 0.6 1.1 2.2 6.7

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Regional Shops*
Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Frosty Fjords
Fish Marketplace

Canned Fish 120 0 16 0.0 0.0 0.0 0.00 0 1 0 1 0 3.8 7.5 15.0 45.0

Fish Soup 400 0 96 0.0 0.0 0.0 0.00 0 1 0 2 0 2 0.6 1.3 2.5 7.5

Salmon Sandwich 2200 0 144 0.0 0.0 0.0 0.00 0 1 0 2 0 0.4 0.8 1.7 5.0

Mountain only, no Beach Total 0 Total 0.0 0.0 0.0 0.00

Cost to open all slots: 288

Limestone Cliffs 
Silk Store

String 120 0 16 0.0 0.0 0.0 0.00 0 2 0 0 3.8 7.5 15.0 45.0

Fan 1100 0 120 0.0 0.0 0.0 0.00 0 2 0 1 0 2 0.5 1.0 2.0 6.0

Robe 2000 0 192 0.0 0.0 0.0 0.00 0 3 0 2 0 1 0.3 0.6 1.3 3.8

no Mountain, no Beach Total 0 Total 0.0 0.0 0.0 0.00

Cost to open all slots: 288

Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Green Valley
Eco Shop

Reusable Bag 120 0 16 0.0 0.0 0.0 0.00 0 2 0 0 3.8 7.5 15.0 45.0

Ecological Shoes 750 0 96 0.0 0.0 0.0 0.00 0 2 0 1 0 1 0.6 1.3 2.5 7.5

Yoga Mat 2000 0 192 0.0 0.0 0.0 0.00 0 3 0 2 0 1 0.3 0.6 1.3 3.8

no Mountain, Beach only Total 0 Total 0.0 0.0 0.0 0.00

Cost to open all slots: 288

Sunny Isles
Tropical Products Store

0 Coconut Oil 120 0 16 0.0 0.0 0.0 0.00 0 2 0 0 3.8 7.5 15.0 45.0

Face Cream 850 0 72 0.0 0.0 0.0 0.00 0 2 0 2 0 0.8 1.7 3.3 10.0

Tropical Drink 2400 0 200 0.0 0.0 0.0 0.00 0 2 0 2 0 1 0.3 0.6 1.2 3.6

no Mountain, Beach only Total 0 Total 0.0 0.0 0.0 0.00

Cost to open all slots: 288

Max Production per hour

Quantity
Max 
Price Total § User

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Cactus Canyon
Car Parts

Motor Oil 120 0 16 0.0 0.0 0.0 0.00 0 2 0 0 3.8 7.5 15.0 45.0

Car Tire 950 0 96 0.0 0.0 0.0 0.00 0 2 0 3 0 1 0.6 1.3 2.5 7.5



Engine 2000 0 192 0.0 0.0 0.0 0.00 0 1 0 1 0 3 0.3 0.6 1.3 3.8

no Mountain, no Beach Total 0 Total 0.0 0.0 0.0 0.00

Cost to open all slots: 288

* Use caution before opening Regions. Once a Region is unlocked, it cannot be relocked, nor can you change your mind and switch it. Its items will become requirements for everything else 
you do. You will also have Region specific tasks added to Contest of Mayors. Many people are tempted to open Regions because they each offer +20 additional storage. However, it is not 
immediately available and takes time to earn enough Regional Simoleons to buy it. Some of that additional space will quickly get used to hold that Region's items. The 2nd and 3rd item in 
each Regional shop also requires multiple items from your Commercial shops. The desire for more storage should not be your reason to open Regions. City offers for the 3rd-tier 
Regional items are very good at approximately §90 per item and acceptable at §80 per item; anything below that, it's usually better to decline and wait for a higher offer.

Seasonal Shops**
Max Production per hour

Quantity
Max 
Price Total §

§ Per 
Hour

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

Santa's Workshop
Toy Horse 120 0 360 20 0.0 0.0 0.0 0.00 0 1 0 1 0 1 3.0 6.0 12.0 36.0

Holiday Decorations 175 0 175 60 0.0 0.0 0.0 0.00 0 3 0 0 1.0 2.0 4.0 12.0

Candy Cane 350 0 117 180 0.0 0.0 0.0 0.00 0 3 0 0 0.3 0.7 1.3 4.0

Gingerbread Cookies 750 0 600 75 0.0 0.0 0.0 0.00 0 1 0 1 0 1 0.8 1.6 3.2 9.6

Holiday Ornament 920 0 1227 45 0.0 0.0 0.0 0.00 0 2 0 1 0 1.3 2.7 5.3 16.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Farm Shop
Farmer's Hayfork 220 0 660 20 0.0 0.0 0.0 0.00 0 1 0 1 0 1 3.0 6.0 12.0 36.0

Box of Grapes 132 0 528 15 0.0 0.0 0.0 0.00 0 3 0 1 0 1 4.0 8.0 16.0 48.0

Wool Shirt 275 0 220 75 0.0 0.0 0.0 0.00 0 2 0 1 0 0.8 1.6 3.2 9.6

Picnic Basket 1320 0 660 120 0.0 0.0 0.0 0.00 0 1 0 2 0 1 0.5 1.0 2.0 6.0

Apple Jam 825 0 495 100 0.0 0.0 0.0 0.00 0 3 0 1 0 1 0.6 1.2 2.4 7.2

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

Max Production per hour

Quantity
Max 
Price Total §

§ Per 
Hour

Time 
(mins)

Total 
(hrs) 2x 4x 12x Total Req Total Req Total Req Regular 2x (120) 4x (240) 12x (720)

future use
0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

> The 2 blocks of rows labeled "future use" will still calculate simoleons and production times if quantity values are entered, but obviously will not be included on materials calculations elsewhere on sheet. 

future use
0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

0 0 1 0.0 0.0 0.0 0.00 0 0 0 60.0 120.0 240.0 720.0

Cost to open all slots: 288 Total 0 Total 0.0 0.0 0.0 0.00

** These shops are only open for short periods during the year. The # of slots you unlock is a highly individual choice due to their brief use. Some shops have returned to 
use, some have not. Santa's Workshop and Farm Shop were used in 2022. Santa's Workshop is currently the seasonal shop that is reliably likely to return annually (in use 
since 2019). Empty blocks labeled "future use" already include formulas, just need to enter relevant values.

Industrial Items Common Times for Mass Production:
Quantity Time § Total § Mins Qty Hrs Mins Qty Hrs Mins Qty Hrs

1m 10 0 16 3 0.8 24 3 1.2 48 3 2.4

3m 20 0 16 4 1.1 24 4 1.6 48 4 3.2

9m 25 0 16 5 1.3 24 5 2.0 48 5 4.0

20m 30 0 16 6 1.6 24 6 2.4 48 6 4.8

30m 40 0 16 7 1.9 24 7 2.8 48 7 5.6

2h 60 0 16 8 2.1 24 8 3.2 48 8 6.4

3h 90 0 16 9 2.4 24 9 3.6 48 9 7.2

4h 110 0 16 10 2.7 24 10 4.0 48 10 8.0

5h 120 0 16 11 2.9 24 11 4.4 48 11 8.8

6h 140 0 16 12 3.2 24 12 4.8 48 12 9.6

7h 160 0

Total 0 40 3 2.0 36 3 1.8 72 3 3.6

Epic Buildings 40 4 2.7 36 4 2.4 72 4 4.8

Regional Industrial Items Total 40 5 3.3 36 5 3.0 72 5 6.0



Time § Capital City 0 40 6 4.0 36 6 3.6 72 6 7.2

Frosty Fjords 6m 30 Frosty Fjords 0 40 7 4.7 36 7 4.2 72 7 8.4

Limestone Cliffs 6m 30 Limestone Cliffs 0 40 8 5.3 36 8 4.8 72 8 9.6

Green Valley 6m 30 Green Valley 0 40 9 6.0 36 9 5.4 72 9 10.8

Sunny Isles 6m 30 Sunny Isles 0 40 10 6.7 36 10 6.0 72 10 12.0

Cactus Canyon 6m 30 Cactus Canyon 0 40 11 7.3 36 11 6.6 72 11 13.2

Total 0 0 0 0 40 12 8.0 36 12 7.2 72 12 14.4

Region Unlock Requirements Mins Qty Hrs Mins Qty Hrs Mins Qty Hrs

1st Level 25 96 3 4.8 0 3 0.0 192 2 6.4

2nd 15,000 96 4 6.4 0 4 0.0 192 3 9.6

3rd 250,000 96 5 8.0 0 5 0.0 192 4 12.8

4th 1,000,000 96 6 9.6 0 6 0.0 192 5 16.0

5th 10,000,000 96 7 11.2 0 7 0.0 192 6 19.2

(Regional population) 96 8 12.8 0 8 0.0 192 7 22.4

96 9 14.4 0 9 0.0 192 8 25.6

Regional Storage: +20 each;  5,000 regional simoleons each 96 10 16.0 0 10 0.0 192 9 28.8

96 11 17.6 0 11 0.0 192 10 32.0

96 12 19.2 0 12 0.0 192 11 35.2

Commercial Slots 192 12 38.4
Building 

Supplies, 
Hardware

All others, 
Regions, 
Seasonal

Vu's Random 
Generator

Mins Qty Hrs Mins Qty Hrs Mins Qty Hrs

Slot # Cost 0 3 0.0 0 3 0.0 0 3 0.0

3 4 8 80 0 4 0.0 0 4 0.0 0 4 0.0

4 10 14 140 0 5 0.0 0 5 0.0 0 5 0.0

5 16 20 200 0 6 0.0 0 6 0.0 0 6 0.0

6 22 26 260 0 7 0.0 0 7 0.0 0 7 0.0

7 28 32 320 0 8 0.0 0 8 0.0 0 8 0.0

8 34 38 380 0 9 0.0 0 9 0.0 0 9 0.0

9 40 44 440 0 10 0.0 0 10 0.0 0 10 0.0

10 46 50 500 0 11 0.0 0 11 0.0 0 11 0.0

11 52 56 560 0 12 0.0 0 12 0.0 0 12 0.0

Total 252 288 2880
Any of the minutes on the Mass Production Chart directly above 
can be adjusted to minutes of your choosing; the corresponding 

totals will automatically adjust.Trade Depot Slots: 10 each up to 32, Total= 260

Omega/Neosims Refunds*** *** NeoBank workaround: Once you have obtained and upgraded enough Omega buildings, your NeoBank 
limit will cap the amount of Neosimoleons you can collect. Instead of just letting the NeoBank sit full, you can 
purchase Omega Bridges (Landscape) or Luxury Beach Houses (Beach) and store many of them for 
demolishing later. You only get 50% back when you demolish, but by doing this you can continue to collect 
and generate more Neosims. Currently, each season of Mayor's Pass Premium offers up to 46,000 Neosims 
rewards. If you collect them all at the end of the season you can easily surpass your NeoBank limit (it is 
suggested you resist collecting those rewards just to complete a Contest of Mayors task). You can also 
combine this with demolishing stored Omega Bridges/Luxury Beach Houses and/or selling Omega items to 
earn enough to buy ControlNets and Drone Bases that are far above your NeoBank limit. City offers for 
Omega items are very good at approximately §1400 per item and acceptable at §1200 per item; anything 
below that is usually not worth selling the item.

Cost for next unit: Quantity Demolish § Total §

( 0  )                0 Omega Bridge
Max cost: 
16,000 8000 ( -  )            

( 0  )                0 Luxury Beach House
Max cost: 
12,000 6000 ( -  )            

( 0  )                0 Omega Power Plant 0 ( -  )            

( 0  )                0 Omega Water Tower 0 ( -  )            

( 0  )                0 Omega Sewage Trtmnt Plnt 0 ( -  )            

( 0  )                0 Omega Recycling Center 0 ( -  )            

( 0  )                0 Small ControlNet 0 ( -  )            

( 0  )                0 Basic ControlNet 0 ( -  )            *** When you demolish an Omega building (not the Omega residences), the cost to build will return to the previous 
cost. Example: you have 2 Basic ControlNets, a 3rd would cost §72,000. You demolish your 2nd and now only have 1. 
The cost will then return to §42,000 to build a 2nd Basic ControlNet again. The increasing cost of buildings includes the 
total building count of all your cities; it is not per city.

( 0  )                0 Deluxe ControlNet 0 ( -  )            

( 0  )                0 Small Drone Base 0 ( -  )            

( 0  )                0 Basic Drone Base 0 ( -  )            

( 0  )                0 Deluxe Drone Base 0 ( -  )            *** The blank spaces are for future use. The demolition refunds for Utilities, ControlNets and Drone Bases 
have been left blank as the building costs change and would need to entered manually. The blank areas are 
included in formulas and will calculate if values are entered.

 ^ 0 0 ( -  )            

 ^ 0 0 ( -  )            

 ^ 0 0 ( -  )            

 ^ 0 0 ( -  )            *** When entering values here, make sure you're entering refund values and not the building cost.

 ^ 0 0 ( -  )            

(Manual entry if 
you'd like to keep 
record instead of 
having to  review 
one-by-one.)

Demolition Refund Total ( -  )            

Current Neosimoleons § >> ( -  )            

Uncollected Rewards § >> ( -  )            

Potential Total ( -  )            

Notes:

  The pre-filled production times and material requirements are all based on fully upgraded shops on a city started prior to mid-2022. Note that there are newer cities that have some variances 
in production times and material requirements. Simply change the appropriate values in the “Time (mins)” column and the “Req” columns to match your city and/or the current levels of your 
shops as needed, the other calculations will fill automatically. Max prices are the same regardless of upgrade level.

Bright-yellow cells show the combined total of required materials for all items that have a quantity entered next to them.



  All item names are listed as they appear in the English (US) version, with the exception of: Sugar and Spices= Spice, Fruit and Berries= Fruit, Electrical Components= Elec Comp, Recycled 
Fabric= Fabric. This is for Search purposes. If you change the names on here to suit your preferences, make sure to change all instances that they appear or the Search will not be useful.

  Column G, labeled “User”, currently has no purpose in the Production area of the calculator other than to hold spacing. It was originally a "§ Per Hour" entry, but that was somewhat 
misleading. It was also intended to be linked to the Income/Simoleon Earning sheet (along with other columns), but it was decided against to avoid errors. It has been left in place as a “User” 
column to do whatever they please with it. It might be suggested using it to mark items that you intend to use for income.

> See Notes and Instructions pages.

> Column spacing is set to accommodate different sets of data on different areas of the sheet. Making columns narrower may result in some of that information being blocked out.

> Excel & Google Sheets versions- columns P, U, Z are intentionally hidden for space. They are only information reference columns and not needed for normal use.

Original Row and Column Sizes:

Rows height- 25; column label rows- 32

Individual Column widths noted on line below:

26 102 33 52 46 62 50 47 47 34 34 34 26 33 33 33 33 33 33 33 33 33 33 33 33 55 55 55 60 18



Income Comparison / Simoleon Earning Calculator by Cid / hvor er jeg Released: November 2023 >  Industrial Materials "Mins" should be adjusted to match your 
game, but they only affect "All Materials" formulas.

Before Using: enter the appropriate values to 
match your game on the "Base Time" column; 
the non-shaded "Req" columns under Required 
Materials; and the "Mins" row on Industrial 
Materials.

Mins 1 3 9 20 30 120 180 240 300 360 420

Main Calculator
§ 10 20 25 30 40 60 90 110 120 140 160

<<< Customized formulas, only "Base Time" entries affect outcomes. <<
|

>> Plain calculator, all entries affect outcomes. >>>

Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison Required Materials

Building Supplies Store
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

Nails 80 4 20.00 1200 5 16.00 4 20.00 4 20.00 1200 | 80 20 60 25% 2 2

Planks 120 24 5.00 300 27 4.44 24 5.00 24 5.00 300 | 120 40 80 33% 2 2

Bricks 190 16 11.88 713 46 4.13 16 11.88 16 11.88 713 | 190 80 110 42% 2 2

Cement 440 40 11.00 660 160 2.75 40 11.00 40 11.00 660 | 440 140 300 32% 2 2 1 1

Glue 440 48 9.17 550 168 2.62 48 9.17 48 9.17 550 | 440 145 295 33% 1 1 2 2

Paint 320 48 6.67 400 168 1.90 48 6.67 48 6.67 400 | 320 180 140 56% 2 2 1 1 2 2

Hardware Store |

Hammer 90 11.2 8.04 482 14.2 6.34 11.2 8.04 11.2 8.04 482 | 90 30 60 33% 1 1 1 1

Measuring Tape 110 16 6.88 413 25 4.40 16 6.88 16 6.88 413 | 110 35 75 32% 1 1 1 1

Shovel 150 24 6.25 375 33 4.55 24 6.25 24 6.25 375 | 150 55 95 37% 1 1 1 1 1 1

Cooking Utensils 250 36 6.94 417 45 5.56 36 6.94 36 6.94 417 | 250 110 140 44% 2 2 2 2 2 2

Ladder 420 48 8.75 525 99 4.24 96 4.38 48 8.75 525 | 420 260 160 62% 2 2 2 2

Drill 590 96 6.15 369 516 1.14 96 6.15 96 6.15 369 | 590 230 360 39% 2 2 2 2 1 1
|

Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison

Farmer's Market
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

Beef 860 120 7.17 430 480 1.79 120 7.17 120 7.17 430 | 860 420 440 49% 3 3

Vegetables 160 16 10.00 600 36 4.44 16 10.00 16 10.00 600 | 160 60 100 38% 2 2

Flour Bag 570 24 23.75 1425 204 2.79 24 23.75 24 23.75 1425 | 570 240 330 42% 2 2 2 2

Fruit 730 72 10.14 608 177 4.12 168 4.35 72 10.14 608 | 730 480 250 66% 2 2 1 1

Cream 440 60 7.33 440 420 1.05 60 7.33 60 7.33 440 | 440 140 300 32% 1 1

Corn 280 48 5.83 350 78 3.59 48 5.83 48 5.83 350 | 280 160 120 57% 1 1 4 4

Cheese 660 84 7.86 471 444 1.49 84 7.86 84 7.86 471 | 660 280 380 42% 2 2

Furniture Store |

Chairs 300 16 18.75 1125 30.2 9.93 27.2 11.03 16 18.75 1125 | 300 210 90 70% 2 2 1 1 1 1

Tables 500 24 20.83 1250 60 8.33 56 8.93 32 15.63 938 | 500 370 130 74% 1 1 2 2 1 1

Home Textiles 610 60 10.17 610 240 2.54 76 8.03 60 10.17 610 | 610 290 320 48% 2 2 1 1

Cupboard 900 36 25.00 1500 336 2.68 132 6.82 96 9.38 563 | 900 800 100 89% 2 2 2 2 1 1

Couch 1810 120 15.08 905 636 2.85 216 8.38 120 15.08 905 | 1810 1300 510 72% 3 3 1 1 1 1
|

Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison

Gardening Supplies
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

Grass 310 24 12.92 775 57 5.44 48 6.46 24 12.92 775 | 310 180 130 58% 1 1 1 1

Tree Saplings 420 72 5.83 350 105 4.00 96 4.38 72 5.83 350 | 420 210 210 50% 2 2 1 1

Garden Furniture 820 108 7.59 456 288 2.85 156 5.26 108 7.59 456 | 820 470 350 57% 2 2 2 2 2 2

Fire Pit 1740 192 9.06 544 392 4.44 304 5.72 192 9.06 544 | 1740 1410 330 81% 2 2 1 1 2 2

Lawn Mower 840 96 8.75 525 516 1.63 144 5.83 96 8.75 525 | 840 510 330 61% 3 3 1 1 1 1

Garden Gnomes 1600 72 22.22 1333 320 5.00 200 8.00 128 12.50 750 | 1600 1320 280 83% 2 2 1 1

Donut Shop |

Donuts 950 36 26.39 1583 276 3.44 60 15.83 36 26.39 1583 | 950 680 270 72% 1 1 1 1

Green Smoothie 1150 24 47.92 2875 201 5.72 192 5.99 88 13.07 784 | 1150 890 260 77% 1 1 1 1

Bread Roll 1840 48 38.33 2300 468 3.93 156 11.79 108 17.04 1022 | 1840 1580 260 86% 2 2 1 1

Cherry Cheesecake 2240 72 31.11 1867 516 4.34 348 6.44 180 12.44 747 | 2240 1960 280 88% 1 1 1 1 1 1

Frozen Yogurt 1750 192 9.11 547 612 2.86 360 4.86 192 9.11 547 | 1750 1280 470 73% 1 1 1 1 1 1

Coffee 750 48 15.63 938 468 1.60 108 6.94 60 12.50 750 | 750 610 140 81% 1 1 2 2 1 1
|

Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison

Fashion Store
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

Cap 600 48 12.50 750 228 2.63 64 9.38 48 12.50 750 | 600 290 310 48% 2 2 1 1

Shoes 980 60 16.33 980 240 4.08 108 9.07 60 16.33 980 | 980 645 335 66% 2 2 1 1 1 1

Watch 580 72 8.06 483 372 1.56 72 8.06 72 8.06 483 | 580 230 350 40% 2 2 1 1 1 1

Business Suits 1170 168 6.96 418 348 3.36 216 5.42 168 6.96 418 | 1170 820 350 70% 3 3 1 1 1 1

Backpack 430 120 3.58 215 300 1.43 136 3.16 120 3.58 215 | 430 340 90 79% 2 2 2 2 1 1

Fast Food Restaurant |

Ice Cream Sandwich 2560 11.2 228.57 13714 491.2 5.21 179.2 14.29 108 23.70 1422 | 2560 2280 280 89% 1 1 1 1

Pizza 2560 19.2 133.33 8000 583.2 4.39 247.2 10.36 228 11.23 674 | 2560 2090 470 82% 1 1 1 1 1 1

Burgers 3620 28 129.29 7757 508 7.13 212 17.08 148 24.46 1468 | 3620 3230 390 89% 1 1 1 1 1 1

Cheese Fries 1050 16 65.63 3938 460 2.28 116 9.05 100 10.50 630 | 1050 820 230 78% 1 1 1 1

Lemonade Bottle 1690 48 35.21 2113 348 4.86 216 7.82 72 23.47 1408 | 1690 1190 500 70% 2 2 2 2 1 1

Popcorn 1250 24 52.08 3125 552 2.26 132 9.47 108 11.57 694 | 1250 1040 210 83% 1 1 2 2
|

Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison

Home Appliances
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

BBQ Grill 530 148 3.58 215 193 2.75 184 2.88 148 3.58 215 | 530 280 250 53% 3 3 1 1



Refrigerator 1060 189 5.61 337 609 1.74 189 5.61 189 5.61 337 | 1060 490 570 46% 2 2 2 2 2 2

Lighting System 890 94 9.47 568 514 1.73 94 9.47 94 9.47 568 | 890 340 550 38% 1 1 1 1 1 1

TV 1280 135 9.48 569 555 2.31 135 9.48 135 9.48 569 | 1280 610 670 48% 2 2 2 2 2 2

Microwave Oven 480 108 4.44 267 528 0.91 108 4.44 108 4.44 267 | 480 320 160 67% 4 4 1 1 1 1

<<< Customized formulas, only "Base Time" entries affect outcomes. << | >> Plain calculator, all entries affect outcomes. >>>

Regional Shops
| Mins §
| 6 30

Frosty Fjords Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison

Fish Marketplace
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

Canned Fish 120 16 7.50 450 22 5.45 16 7.50 16 7.50 450 | 120 40 80 33% 1 1 1 1

Fish Soup 400 96 4.17 250 177 2.26 168 2.38 96 4.17 250 | 400 720 -320 180% 1 1 2 2 2 2

Salmon Sandwich 2200 144 15.28 917 612 3.59 300 7.33 144 15.28 917 | 2200 1900 300 86% 1 1 2 2

Limestone Cliffs Silk Store |

String 120 16 7.50 450 22 5.45 16 7.50 16 7.50 450 | 120 60 60 50% 2 2

Fan 1100 120 9.17 550 336 3.27 216 5.09 120 9.17 550 | 1100 960 140 87% 2 2 1 1 2 2

Robe 2000 192 10.42 625 432 4.63 288 6.94 192 10.42 625 | 2000 1340 660 67% 3 3 2 2 1 1

Green Valley Eco Shop |

Reusable Bag 120 16 7.50 450 22 5.45 16 7.50 16 7.50 450 | 120 60 60 50% 2 2

Ecological Shoes 750 96 7.81 469 264 2.84 144 5.21 96 7.81 469 | 750 610 140 81% 2 2 1 1 1 1

Yoga Mat 2000 192 10.42 625 492 4.07 328 6.10 192 10.42 625 | 2000 1630 370 82% 3 3 2 2 1 1
|

Sunny Isles Base 
Time 
(mins)

All Materials Sans 
Industrial 
Materials

Mass Production | Purchased Materials Price vs Produced 
Materials Price Comparison

Tropical Products Store
Max 
Price

§ per 
Min

§ per 
hour

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

Time 
(mins)

§ per 
Min

§ per 
hour

| Max 
Price

Cost- All 
Materials

Adjusted 
Price

Value 
Loss PurchasedReq. PurchasedReq. PurchasedReq.

Coconut Oil 120 16 7.50 450 22 5.45 16 7.50 16 7.50 450 | 120 60 60 50% 2 2

Face Cream 850 72 11.81 708 192 4.43 104 8.17 72 11.81 708 | 850 360 490 42% 2 2 2 2

Tropical Drink 2400 200 12.00 720 449 5.35 440 5.45 200 12.00 720 | 2400 1630 770 68% 2 2 2 2 1 1

Cactus Canyon Car Parts |

Motor Oil 120 16 7.50 450 22 5.45 16 7.50 16 7.50 450 | 120 60 60 50% 2 2

Car Tire 950 96 9.90 594 264 3.60 144 6.60 96 9.90 594 | 950 740 210 78% 2 2 3 3 1 1

Engine 2000 192 10.42 625 708 2.82 288 6.94 192 10.42 625 | 2000 990 1010 50% 1 1 1 1 3 3

<<< Customized formulas, only "Base Time" entries affect outcomes. << | >> Plain calculator, all entries affect outcomes. >>>
>  Base Time (Production Time) directly above is 
included in all time formulas. It should be adjusted to 
match your game. All calculations will adjust 
accordingly.

>  The Required Materials columns only affect the "Purchased 
Materials Price vs Produced Materials Price" comparison. Adjusting the 
shaded "Purchased" quantities will adjust the calculations accordingly. 
You can experiment with these numbers to see which combination of 
Purchased items and Produced items may be more beneficial. Quantity 
adjustments do not affect the Time formulas in any way.Sections:

>  All Materials-  time needed to produce an item starting from the basic Industrial Materials up to the finished product. Instances of redundant Industrial time are already removed.

>  Only the shaded "Purchased" columns directly above are 
calculated for experimenting; the non-shaded "Req" columns are not 
calculated, they are meant to be a reference for your game's 
requirements.

>  Sans Industrial Materials-  time needed to produce all Required Materials up to the finished product, excluding time needed for producing Industrial Materials.

>  Mass Production-  time needed to produce items in an assembly line fashion with the shortest time necessary. Assumes a back-stock of Required Materials 
has NOT already been produced (other than Industrial Materials) and that Required Materials are being produced simultaneously.

>  Purchased Materials Price vs Produced Materials Price-  see notes under Required Materials.

Notes:

  This chart is primarily aimed at newer players, as the most immediate question after starting is always, "How can I earn the most Simoleons?". There is no answer to the question because everybody plays the game 
differently and what works the best for some will not be the same as for others. Even players with the same maxed Shops, Factories, Trade Depots and availability of resources will not have the same method of earning 
income. Shop levels, time spent in-game vs away, the number of Commercial slots and Trade Depots unlocked, Vu's Random Generator, Events participated in vs not participated in; all affect the viability of one set of items 
compared to other sets of items. The chart is to aid the individual in determining their best options by giving them all the information upfront. Users can further craft more formulas or algorithms with this information if they so desire.

  Unlike the Multi-Purpose Production Calculator, the Time formulas here are not "plug and play"; they are each made individually, based on the Assumptions list below. Adjusting the "Base Time" will automatically adjust 
all time formulas accordingly, but the formulas are otherwise manually created on a case-by-case basis. However, the Purchased Materials Price vs Produced Materials Price Comparison is "plug and play"; the values 
in that section are interconnected and will change according to your entries.

Time Assumptions:
> That any given item has been produced from beginning to final product without purchasing Required Materials from the Trade HQ or items gained as other rewards, except as noted for Industrial Materials.

> The individual items and their Required Materials are the only items being produced at a given time.

> When multiple Industrial Materials are needed for the same product, only the item with the longest production time is calculated for total time as the others can be produced simultaneously.

> When multiple Commercial items are needed for the same product, only the item with the longest production time is calculated for total time; UNLESS some of the items come from the same source shop, in which case the times 
for both items are included, as they must be produced in succession; UNLESS items coming from the same source shop have enough variance in time that one can be produced within the time necessary for the Required Materials of the other 
item to be produced.

> When a combination of Industrial items and Commercial items are required, the item with longest production time is used, as the others can be produced simultaneously.

The Time formulas were reviewed a couple times, there could still be errors. End-user can change if they please.

  As noted on the Multi-Purpose Production Calculator, there are variances in Required Materials and Production times from older cities compared to some newer cities. The pre-filled "Base Times" (Production)  and 
Required Materials are from a city with fully upgraded shops, started prior to mid-2022. This should not pose any problems.

The below notes only apply to this sheet:

>  The time formulas will adjust automatically when adjusting the "Base Time" column to match your game. 

>  The Required Materials columns are not referenced in the Time formulas in any way. As such they are completely fluid and adjustments made there only affect the Price Comparison side of the chart.

>  If the Required Materials quantities are different, check to see if that change alters the end result of a formula with regard to the assumptions set forth above. Not much difference is expected.

>  It's presumed (from limited forum information over a year) that the main differences are regarding time for Seeds and the Required Materials for the Building Supplies and Hardware stores. It is anticipated that any 
variations would not likely result in any significant net-change.



>  This sheet is intentionally not linked to the Multi-Purpose Production Calculator in order to prevent the potential for cascading errors during end-user edits on either sheet. The only purpose of doing so would be to save 
time from filling the same information on 2 sheets. However, one can merely copy/paste as well. Instructions, if you want to link them:

Example:

Link Nails time on this sheet from Nails time on the Production Calculator, use the formula:

='Production Calculator'!H10

In this case, H10 is the Nail reference cell from the Production Calculator sheet. Hammer would be H19, etc. You must do this for 
the first item on every section, then you can drag the result down for the remaining items in those sections.

Warning: The sheet Title in this type of formula needs to match exactly, an extra space or missing spaces can cause problems. 
Also, copy/pasting from a notepad can sometimes cause problems if the apostrophe is styled differently.

This can be used for any cells you would like to have linked from the Production Calculator sheet, whether it is the "Base Time" or "Req" cells.

> Excel & Google Sheets versions- columns Z, AE, AJ are intentionally hidden for space. They are only information reference columns and not needed for normal use.

Original Row and Column Sizes:

Rows height- 25; column label rows- 33

Individual Column widths noted on line below:

19 97 33 43 45 43 43 19 45 43 19 45 43 19 45 43 43 40 33 43 63 60 47 33 33 40 33 33 33 40 33 33 33 40 33 19



Design Challenge / Regions by Cid / hvor er jeg

Released: November 2023 Services
# Power § Cost Demand Total Total

Max 
Population*

Service 
Demand

Base 
Demand

Region +1 
Demand

Total Service Demand Wind Plant 600 6 ( -  )    ( -  )

# Bldgs Zone Map Power Water Sewage Waste Coal Plant 450 12 ( -  )    ( -  )

Residential 1836 Low 1 2 Deluxe Wind Plant 1500 22 ( -  )    ( -  )

Florentine 1836 Low 1 2 Capital 0 0 0 0 Solar Plant 2200 35 ( -  )    ( -  )

Art Nouveau 1836 Low 1 2 Oil Plant 1500 40 ( -  )    ( -  )

Old Town House 300 Low 1 2 Power+1 each bldg Frosty Fjords 0 0 0 0 Nuclear Plant 3500 60 ( -  )    ( -  )

Latin America 1836 Low 1 2 Fusion Plant 9000 75 ( -  )    ( -  )

Parisian 2019 Medium 2 3 Power+1 each bldg Sunny Isles 0 0 0 0 Omega Plant 10,000 100 ( -  )    ( -  )

London Town 2111 Medium 2 3 Eco Power Plant 28 ( -  )    ( -  )

Tokyo Town 2204 Medium 2 3 Water+1 each bldg Cactus Canyon 0 0 0 0 ** ( -  )    ( -  )

Green Valley 2347 Medium 2 3 Total ( -  )    ( -  )

Cactus Canyon 2347 Medium 2 3 Sewage+1 each bldg Limestone Cliffs 0 0 0 0

Sunny Isles 2347 Medium 2 3 Water § Cost Demand Total Total

Frosty Fjords 2347 Medium 2 3 Waste+1 each bldg Green Valley 0 0 0 0 Basic Plant 600 9 ( -  )    ( -  )

Limestone Cliffs 2347 Medium 2 3 Pumping Station 4500 55 ( -  )    ( -  )

Omega 2550 High 5 6 Omega Tower 6500 100 ( -  )    ( -  )

Epic 2411 Low 1 2 ** ( -  )    ( -  )

** 1 Low 1 2 Fire 1 2 3 4 ** ( -  )    ( -  )

** 1 Low 1 2 Small Fire Station 0 Total ( -  )    ( -  )

** 1 Low 1 2 Basic Fire Station

** 1 Low 1 2 Deluxe Fire Station Sewage § Cost Demand Total Total

** 1 Medium 2 3 Small Outflow Pipe 400 7 ( -  )    ( -  )

** 1 Medium 2 3 Police 1 2 3 4 Basic Outflow Pipe 1200 28 ( -  )    ( -  )

** 1 Medium 2 3 Small Police Station 0 Deluxe Plant 3500 55 ( -  )    ( -  )

** 1 Medium 2 3 Basic Police Station Omega Plant 6000 100 ( -  )    ( -  )

** 1 High 5 6 Police Precinct ** ( -  )    ( -  )

** 1 High 5 6 ** ( -  )    ( -  )

** 1 High 5 6 Health 1 2 3 4 Total ( -  )    ( -  )

** 1 High 5 6 Small Health Clinic 0

0 Total Health Clinic Waste § Cost Demand Total Total

Hospital Small Dump 600 15 ( -  )    ( -  )

Total Max Population* ( -  )          Table is here in case you'd like to track the costs of 
these. Costs change based on League. Most of the 
time, the 1st small fire, police, health are provided at 
the start of the challenge (not always). This section is 
rather useless, to be honest, but included it anyway.

Garbage Dump 1200 31 ( -  )    ( -  )

Incinerator 1500 40 ( -  )    ( -  )

Recycling Center 6000 70 ( -  )    ( -  )

Omega Center 10,000 100 ( -  )    ( -  )

** The blank rows above are for new buildings that may be added to Design 
Challenge (or Regular Maps) in the future. They are already included in the 
existing formulas. If they do add them, simply adjust the values for Max 
Population, Base Demand and the appropriate value for the Region +1 
Demand. The formulas will still work.

** ( -  )    ( -  )

** ( -  )    ( -  )

Season Plot/Building rewards have 
typically come in several combinations:

Total ( -  )    ( -  )

• 1 new unique and 2 unique repeats. ** The blank rows above are for new buildings or reward 
items, such as the Eco Power Plant, if they are added later. 
These rows are already included in the existing formulas and 
will work if values are entered.

* Max Population & Total Max Population cells do not include boosts from 
Specializations.

• 3 unique repeats.

• 1 new unique and 2 regulars.

• 1 unique repeat and 2 regulars.

• 2 unique repeats and 1 regular.

• 1 new unique, 1 unique repeat, 1 regular.

Notes:

In Design Challenge, Medium and High are equal to Low and Medium on the Regular maps. This may change to reflect the Regular maps in future, there are not yet Omegas in Design Challenge. (Currently March 2023).

This sheet was primarily meant for players new to Design Challenge, but others might find use for it in their Regions/Capital.

All Specialization plots/buildings used in Design Challenge are returned to your inventory after Submitting your design. 

Earned Blueprints do NOT carry over to the next season, use them while you have them.

  During Design Challenges, the only buildings that require roads are the Residences, Services and any Specializations required for bonuses. All other plots/buildings can be placed without any 
roads. They will have road warning bubbles above them until you are ready to Submit, at which point they will disappear. As in your regular cities, Landscapes never require any roads. Roads do 
not need to connect to the "main" roads at the edges of maps.

  If you intend to replace regular roads with upgraded roads prior to Submitting, take caution to use trees or other landscapes to prevent nearby plots/buildings from auto-positioning when 
you demolish the regular road. Failing to do so can be cause for frustration if you have spent much time positioning everything a particular way.

Epics are the same population regardless of being Bronze, Silver or Gold. They still retain the Residential Service Demand after the upgrade.

  For Design, the above calculations will become trivial. The only population you actually need is the amount required to obtain the Bonus. Once you have plenty of Specializations, you 
can get by with just 3 or 4 maxed Regional buildings to achieve that.

Weeping Willow Forests (Green Valley), Cypress Forests and Coconut Tree Forests can keep much of their green color in the snowy sections of Frosty Fjords, whereas others will be mostly covered by snow.



Full 24hr cycle: 10mins, Night lights: approx 2mins 30secs Total 2x2 Spaces Arbitrary Reductions 
for Roads and Services ? ?

Potential 
Availability For 

ResidencesTotal Land Tiles
Original Formulas for: Capital 4300 1075

To Be Continued (or not; very subjective assumptions and ratios would 
have to be made here).

For any that might be curious, this area would have been intended for 
those wanting to somewhat plan a way to achieve the 10M Regional 
population to unlock the 5th Region in the shortest time. My interest is 
minimal, as with 4 opened, the 5th is not a strong desire for me. I've 
chosen to just let the 4 I have evolve into whatever aesthetic they are 
going to grow into without concern for getting the 5th.

The premise would have been to use Frosty Fjords as the model, as it is 
the hardest and any layout could easily port over to other Regions and 
be adjusted accordingly. It would be to maximize population at the 
complete expense of aesthetics and use that model on the other 4 
Regions until reaching 10M population. I left Cactus Canyon for last, but 
it would be the easiest one to max out due to its layout. I opened 
Regions soley based on which trees I wanted access to. It is unknown 
how many more years the game will be supported.

Population: 0 Frosty Fjords 2880 720

Base Demand: 0 Limestone Cliffs 3136 784

Regional +1 Demand: 0 Green Valley 3072 768

Sunny Isles 3200 800

Cactus Canyon 3136 784

Total Land Tile data are not 
my own work. Sources:

https://imgur.com/a/dPnUS4l

https://www.reddit.com/media?url=https%3A%
2F%2Fi.redd.it%2Fib737q34234a1.jpg

Original Row and Column Sizes:

All Rows height- 25

Individual Column widths noted on line below:

22 46 105 77 22 60 60 68 22 22 91 122 45 45 52 45 35 33 113 46 54 56 37 22

https://imgur.com/a/dPnUS4l
https://www.reddit.com/media?url=https%3A%2F%2Fi.redd.it%2Fib737q34234a1.jpg
https://www.reddit.com/media?url=https%3A%2F%2Fi.redd.it%2Fib737q34234a1.jpg


Black Friday / Inventory List by Cid / hvor er jeg Released: November 2023, Updated Dec 2023 > The Black Friday schedule for 2022 was: Wednesday & Thursday- Parks/Education/Entertainment. Friday & Saturday- 
Landscape/Transport/Gambling. Sunday- Beach/Mountain/Landmarks. Monday- All Specializations.

Enter 
Starting 
Funds 
Here>>

§ Gold 
Keys

Plat 
Keys

Sim 
Cash

Regional Trees Hot Spots > The Black Friday schedule for 2023 was unusual: Monday, Tuesday, 1/2 of Wednesday- Parks/Education/Entertainment. 1/2 of 
Wednesday, Thursday, Friday- Landscape/Transport/Gambling. Saturday, 1/2 of Sunday- Beach/Mountain/Landmarks. 1/2 of 
Sunday, Monday- All Specializations. (These approximate half-days were per UTC time.)Limited-Time Items Neosimoleon Item

> During Black Friday week, all Specializations are 50% off, regardless of whether they are priced in Simcash, Keys or Simoleons. The 
50% off only applies to Specializations.Design Challenge Legend Starting Regional Funds

*P*= Creates Parade B= Bright at Night Frosty Fjords Sunny Isles > The references to Bright and Very Bright on the Design Challenge Legend are meant as an aid for finding plots for night 
designs/themes with less trial and repetition.

NE= Night Effects VB= Very Bright at Night Limestone Cliffs Cactus Canyon

AA= Aerial Animations Green Valley (Future Use)

Landscape Parks
Cost Total Cost Total

§ Gold 
Keys

Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash Region § § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
CashPlot Own Want Plot Own Want

Pond - - - - - Small Fountain Park - - - - -

Lake - - - - - Modern Art park - - - - -

Big Lake - - - - - B Plumbob Park - - - - -

Icelandic Hills - - - - - Crescent Tent - - - - -

Large Icelandic Hills - - - - - Ruined Bell Tower - - - - -

Icelandic Volcano - - - - - Jack-o'-lantern - - - - -

Icelandic Horses - - - - - *P* The Cursed Swamp - - - - -

Icelandic Hot Springs - - - - - Feathery Mansion - - - - -

Small Animal Pastures - - - - - NE Haunted Sanitarium - - - - -

Large Animal Pastures - - - - - NE Deserted Farm - - - - -

Small Flower Fields - - - - - NE Streets of Diwali - - - - -

Large Flower Fields - - - - - B Holiday Park - - - - -

Small Vineyards - - - - - B Ice Skating Rink - - - - -

Large Vineyards - - - - - Holiday Tree - - - - -

Apple Tree - - - - - VB Big Ice Skating Rink - - - - -

Apple Forest - - - - - B Carnival Gate - - - - -

Flowery City Name - - - - - *P* Carnival Party - - - - -

Elevated Promenade - - - - - B Heart Balloon Park - - - - -

B Modern Greenway - - - - - Chicken Park - - - - -

B Aqueduct - - - - - Swan Boat Park - - - - -

B Food Alleyways - - - - - Cottontail Slide - - - - -

- - - - - University Park Cafeteria - - - - -

City Wall Section - - - - - B University Park Quad - - - - -

City Gates - - - - - - - - - -

Round Tower - - - - - Reflecting Pool Park - - - - -

Grey Wall Section - - - - - Larry the Llama - - - - -

Iron Gate - - - - - Peaceful Park - - - - -

Square Tower - - - - - Urban Plaza - - - - -

Wall of Shi - - - - - World's Largest Ball of Twine - - - - -

Gate of Shi - - - - - Sculpture Garden - - - - -

Tower of Shi - - - - - Row of Trees - - - - -

Wall of Alsharq - - - - - - - - - -

Gate of Alsharq - - - - - Anchor Park - - - - -

Tower of Alsharq - - - - - B Casino City Sign - - - - -

- - - - - B Casino City Park - - - - -

Plumbob Bridge - - - - - Soccer Field - - - - -

Suspension Bridge - - - - - Baseball Park - - - - -

B Omega Bridge - - - - - B Swimming Pool - - - - -

Covered Bridge - - - - - Golf Course Front 9 - - - - -

Cobblestone Bridge - - - - - B Golf Course Back 9 - - - - -

University Bridge - - - - - Jogging Path - - - - -

University of Arts Bridge - - - - - Water Park Playground - - - - -

University of Sciences Bridge - - - - - Giant Garden Gnome - - - - -

Brass Arch Bridge - - - - - Basketball Court - - - - -

George Washington Bridge - - - - - Dolly the Dinosaur - - - - -

Brooklyn Bridge - - - - - Tokyo Town Gate - - - - -

B Threefold Bridge - - - - - Fish Market - - - - -

Riverboat - - - - - Old Palace Park - - - - -

Steamboat - - - - - Skate Park - - - - -

B Riverside Restaurant - - - - - Sakura Park - - - - -

B Big Riverside Restaurant - - - - - B Geometric Sculpture - - - - -

- - - - - Dutch Windmill - - - - -

Small Acacia Forest - - - - - Royal Garden - - - - -

Acacia Forest - - - - - B Omega Park - - - - -

Small Pine Forest - - - - - B Ultimate Mayor Statue - - - - -

Pine Forest - - - - - B Parliament Park - - - - -

Small Aspen Grove - - - - - B St. James' Park - - - - -

Aspen Grove - - - - - B Windsor Home Park - - - - -

(REGIONAL TREES AT END OF LIST) - - - - - Dog Sledding Tour - - - - -

Small Sakura Forest - - - - - B Ice Sculpture Show - - - - -

Sakura Forest - - - - - B Reindeer Farm - - - - -

Dusty Desert - - - - - VB Dragon Dance - - - - -

Prairie Point - - - - - VB Lantern Festival - - - - -

Autumn Oak Tree - - - - - B The Nutcracker Ballet Hall - - - - -

Autumn Oak Forest - - - - - Straw Goat - - - - -

Small Japanese Maple Forest - - - - - Giant Snowman - - - - -



Japanese Maple Forest - - - - - VB Winter Bonfire - - - - -

Small Weeping Birch Forest (Y) - - - - - Medieval Market - - - - -

Weeping Birch Forest (Y) - - - - - The Lover's Pathway - - - - -

Small Aspen Forest - - - - - Posada - - - - -

Aspen Forest - - - - - B De Luxe Department Store - - - - -

Birch Tree (G) - - - - - VB Little Candles Paza - - - - -

Birch Forest (G) - - - - - VB Romantic Holiday Plaza - - - - -

Silver Fern Tree - - - - - Pohutukawa Tree Field - - - - -

Silver Fern Forest - - - - - VB Giant Lantern Festival - - - - -

Pohutukawa Tree - - - - - B Festival of Breaking the Fast - - - - -

Pohutukawa Forest - - - - - VB Year of the Tiger - - - - -

Coconut Tree - - - - - VB Whatville - - - - -

Coconut Tree Forest - - - - - B Farm Mansion - - - - -

Small Cypress Forest - - - - - Floating Pod - - - - -

Cypress Forest - - - - - NE Winter Holiday Street - - - - -

- - - - - NE Winter Holiday Park - - - - -

Tumbleweed Station - - - - - B Atelier du Chocolate - - - - -

Covered Wagon Camp Site - - - - - NE Iftar Market Square - - - - -

Rocky Pastures - - - - - Majestic Umbrella Hall - - - - -

Western Springs - - - - - B Round Castle - - - - -

Winter Forest - - - - - Loggia del Llamalino - - - - -

Old Farm - - - - - London Kew Gardens - - - - -

Sheep Field - - - - - - - - - -

Horse Ranch - - - - - - - - - -

Deer Meadow - - - - - - - - - -

Bear Cave - - - - - - - - - -

Rabbit Forest - - - - - - - - - -

Old Watermill - - - - - - - - - -

Small Campsite - - - - - - - - - -

Campsite - - - - - - - - - -

Hot Spring - - - - - - - - - -

Crop Circle - - - - - - - - - -

Stonehenge - - - - - - - - - -

Camping on the Lake - - - - - - - - - -

Tent Camping - - - - - - - - - -

Swan Lake - - - - - - - - - -

Greenhouse - - - - - - - - - -

Relaxing Garden Plaza - - - - - - - - - -

Cottage in the Forest - - - - - - - - - -

Grand Tuscan Villa - - - - - - - - - -

Wetlands Preserve - - - - - - - - - -

Firefly Forest - - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

Small Bamboo Forest  (LC) - - - - - - - - - -

Bamboo Forest  (LC) - - - - - - - - -

Small Palm Tree Forest  (SI) - - - - - - - - - -

Palm Tree Forest  (SI) - - - - - - - - -



Small Joshua Tree Forest  (CC) - - - - - - - - - -

Joshua Tree Forest  (CC) - - - - - - - - -

Small Spruce Forest  (FF) - - - - - - - - - -

Spruce Forest  (FF) - - - - - - - - -

Small Weeping Willow Forest  (GV) - - - - - - - - - -

Weeping Willow Forest  (GV) - - - - - - - - -

(future use) - - - - - - - - - -

(future use) - - - - - - - - -

Total - Total - - - - Total - Total - - - -

Remaining Funds - - - - Remaining Funds - - - -

Frosty Fjords - Green Valley - Cactus Canyon - Frosty Fjords - Green Valley - Cactus Canyon -

Limestone Cliffs - Sunny Isles - (Future Use) - Limestone Cliffs - Sunny Isles - (Future Use) -

Beach Mountain
Cost Total Cost Total

§ Gold 
Keys

Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
CashPlot Own Want Plot Own Want

Surfer Beach - - - - - City Name Sign - - - - -

Volleyball Court - - - - - Cozy Cottages - - - - -

Rowing Center - - - - - Mountainside Cottages - - - - -

Beach Volleyball Center - - - - - Hiker's Cottages - - - - -

Bicycle Motocross Center - - - - - Alpine Café - - - - -

Lifeguard Tower - - - - - Mountainside Train Station - - - - -

B Beachfront Shopping Mall - - - - - Whitewater Park - - - - -

VB Crescent Shopping Mall - - - - - B Paragliding Center - - - - -

B Beach Wedding - - - - - Mountain Bike Park - - - - -

Relaxing Beach - - - - - Alpine Vineyard - - - - -

Merman Statue - - - - - Mountain Lift - - - - -

Carousel - - - - - Halfpipe - - - - -

Bluebeard's Pirate ship - - - - - Ski Jumping Hill - - - - -

Water Park - - - - - Ski Hotel - - - - -

Aquarium - - - - - B Ski Resort - - - - -

Astro-Twirl Rocket Ride - - - - - Communication Tower - - - - -

B Lighthouse - - - - - Observatory - - - - -

Sailorman's Pier - - - - - Mount SimCity - - - - -

B Luxury Boat Marina - - - - - Mountain Palace - - - - -

Beach Delta - - - - - Castle - - - - -

Waterfront Wharf - - - - - Mountain Climbing Camp - - - - -

B Yacht Club - - - - - B Waterfall Castle - - - - -

Boat House - - - - - Stone Face Waterfall - - - - -

B Luxury Beach House - - - - - B Gritty Gold Mine - - - - -

B Ocean Villa - - - - - Petra Ruins - - - - -

Sailing Club - - - - - NE Count's Castle - - - - -

Guardian of Sailors - - - - - NE Northern Lights Castle - - - - -

B Paradise Island - - - - - - - - - -

B Luxury Beach Hotel - - - - - - - - - -

B Lighthouse of SimCity - - - - - - - - - -

NE Ghost Fortress - - - - - - - - - -

B Eastegg Island - - - - - - - - - -

B Santa Beach Party - - - - - - - - - -

B Nordic Fishing Dock - - - - - - - - - -

B Beach Sauna Bar - - - - - - - - - -

B 2022 Party Island - - - - - - - - - -

B Oceanic Garden - - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

Total - Total - - - - Total - Total - - - -



Remaining Funds - - - - Remaining Funds - - - -

Frosty Fjords - Green Valley - Cactus Canyon - Frosty Fjords - Green Valley - Cactus Canyon -

Limestone Cliffs - Sunny Isles - (Future Use) - Limestone Cliffs - Sunny Isles - (Future Use) -

Entertainment Education
Cost Total Cost Total

§ Gold 
Keys

Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash Region § § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash Region §

Plot Own Want Plot Own Want

Entertainment HQ - - - - - Department of Education - - - - -

Hotel - - - - - Nursery School - - - - -

Amphitheater - - - - - Grade School - - - - -

Expo Center - - - - - Public Library - - - - -

B Tennis Stadium - - - - - High School - - - - -

B Track and Field Stadium - - - - - Community College - - - - -

B Baseball Stadium - - - - - University - - - - -

B Football Stadium - - - - - University Athletic Field - - - - -

B Soccer Stadium - - - - - B University Rowing Center - - - - -

Globe Theatre - - - - - B Omega University - - - - -

Stadium - - - - - University Campus Park - - - - -

B Sydney Opera House - - - - - University Library - - - - -

Ferris Wheel - - - - - (HOT SPOTS AT END OF LIST) - - - - -

Sumo Hall - - - - - Artist Atelier - - - - -

Oslo Opera House - - - - - The Simli Museum - - - - -

Ice Hockey Arena - - - - - - - - - -

VB Arctic Hotel - - - - - - - - - -

Wedding Hall - - - - - - - - - -

VB Sims' Night Club - - - - - - - - - -

B Mardis Gras - - - - - - - - - -

B Flower Festival - - - - - - - - - -

B Speed Skating - - - - - - - - - -

Modern Treehouse - - - - - - - - - -

Urban Garden - - - - - - - - - -

Treetop Adventure Park - - - - - - - - - -

(HOT SPOTS AT END OF LIST) - - - - - - - - - -

B Caravanserai Restaurant - - - - - - - - - -

*P* SCBI 7th Anniversary - - - - - - - - - -

Glass Egg Hall - - - - - - - - - -

- - - - - - - - - -

- - - - - Contemporary Art Museum (GV) - - - - -

- - - - - Martial Arts School (LC) - - - - -

- - - - - Northern Lights Research (FF) - - - - -

- - - - - Oceanographic Institute (SI) - - - - -

- - - - - Secret Research Lab (CC) - - - - -

- - - - - (future use) - - - - -

- - - - - Total - Total - - - -

- - - - -

- - - - - Remaining Funds - - - -

- - - - - Frosty Fjords - Green Valley - Cactus Canyon -

- - - - - Limestone Cliffs - Sunny Isles - (Future Use) -

- - - - -

- - - - -

- - - - - Transportation
- - - - -

- - - - - Cost Total
- - - - - § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash Region §

- - - - - Plot Own Want

- - - - - Department of Transportation - - - - -

- - - - - Bus Terminal - - - - -

- - - - - London Bus Terminal - - - - -

- - - - - AA Airship Hangar - - - - -

- - - - - AA Balloon Park - - - - -

- - - - - AA Heliport - - - - -

- - - - - B Omega Tube Terminal - - - - -

- - - - - B Alpha Taxi Station - - - - -

- - - - - Bus Terminal (large) - - - - -

- - - - - (HOT SPOTS AT END OF LIST) - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -



- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - - - - - -

- - - - - Bicycle Rental  (GV) - - - - -

Pet Park  (GV) - - - - - Hoverboard Terminal  (GV) - - - - -

Tea House  (LC) - - - - - Tuk Tuk Station  (LC) - - - - -

UFO Landing Site  (CC) - - - - - Big Rig Route  (CC) - - - - -

Longship Museum  (FF) - - - - - Quad Bike Station  (FF) - - - - -

Luau Party  (SI) - - - - - Taxi Shop  (SI) - - - - -

(future use) - - - - - (future use) - - - - -

Total - Total - - - - Total - Total - - - -

Remaining Funds - - - - Remaining Funds - - - -

Frosty Fjords - Green Valley - Cactus Canyon - Frosty Fjords - Green Valley - Cactus Canyon -

Limestone Cliffs - Sunny Isles - (Future Use) - Limestone Cliffs - Sunny Isles - (Future Use) -

Landmarks Gambling
Cost Total Cost Total

§ Gold 
Keys

Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash § Gold 

Keys
Plat 
Keys

Sim 
Cash Region §

Plot Own Want Plot Own Want

Department of Culture - - - - - Gambling HQ - - - - -

B Tower of Pisa - - - - - Gambling House - - - - -

B Big Ben - - - - - Sleek Casino - - - - -

B Arc de Triomphe - - - - - Sleek Casino Tower - - - - -

Brandenburg Gate - - - - - B Sci-fi Casino - - - - -

B Empire State Building - - - - - Sci-fi Casino Tower - - - - -

Statue of Liberty - - - - - Luxurious Casino - - - - -

Washington Monument - - - - - Luxurious Casino Tower - - - - -

Himeji Castle - - - - - B Omega Casino - - - - -

B Eiffel Tower - - - - - B House of Spades Casino - - - - -

B Cinquantenaire Arch - - - - - VB Snake Eyes Casino - - - - -

B Giralda - - - - - VB Lucky Stars Casino - - - - -

Tokyo Tower - - - - - B Sin City Casino - - - - -

Kölner Dom - - - - - VB Four Aces Casino - - - - -

B Willis Tower - - - - - (HOT SPOTS AT END OF LIST) - - - - -

MaxisMan Statue - - - - - - - - - -

B Omega Tower - - - - - - - - - -

Old Town Stronghold - - - - - - - - - -

City Fortress - - - - - - - - - -

Countess' Citadel - - - - - - - - - -

Princess' Tower - - - - - - - - - -

Royal Castle - - - - - - - - - -

Imperial Palace - - - - - - - - - -

B Temple of Artemis - - - - - - - - - -

Mausoleum at Halicarnassus - - - - - - - - - -

Hanging Gardens of Babylon - - - - - - - - - -

Nazca Bird - - - - - - - - - -

Nazca Llama - - - - - - - - - -

Church - - - - - - - - - -

Mosque - - - - - - - - - -

Temple - - - - - - - - - -

Modern Temple - - - - - - - - - -

B Pont Neuf - - - - - B Mahjong Hall  (LC) - - - - -

B Museum of Natural History - - - - - B Oasis Casino  (CC) - - - - -

Eltham Palace - - - - - B Ice Casino  (FF) - - - - -

- - - - - VB Volcano Casino  (SI) - - - - -

- (future use) - - - - -

- - - - - Total - Total - - - -

- - - - -

- - - - - Remaining Funds - - - -

- - - - - Frosty Fjords - Green Valley - Cactus Canyon -

- - - - - Limestone Cliffs - Sunny Isles - (Future Use) -

- - - - -

- - - - -

- - - - - Regional Totals*
- - - - -

- - - - - Frosty Fjords Region § Simcash Sunny Isles Region § Simcash

- - - - - Small Spruce Forest - Small Palm Tree Forest -

- - - - - Spruce Forest - Palm Tree Forest -

- - - - - Northern Lights Research Inst. - Oceanographic Institute -

- - - - - Quad Bike Station - Taxi Shop -

- - - - - Longship Museum - Luau Party -

- - - - - Ice Casino - Volcano Casino -

- - - - - Upgrades (manual entry) Upgrades (manual entry)

- - - - - Total - Total -



- - - - - Starting Funds Starting Funds

- - - - - Remaining - Remaining -

- - - - -

- - - - - Limestone Cliffs Region § Simcash Cactus Canyon Region § Simcash

- - - - - Small Bamboo Forest - Small Joshua Tree Forest -

- - - - - Bamboo Forest - Joshua Tree Forest -

Total - Total - - - - Martial Arts School - Secret Research Lab -

Tuk Tuk Station - Big Rig Route -

Remaining Funds - - - - Tea House - UFO Landing Site -

Frosty Fjords - Green Valley - Cactus Canyon - Mahjong Hall - Oasis Casino -

Limestone Cliffs - Sunny Isles - (Future Use) - Upgrades (manual entry) Upgrades (manual entry)

Total - Total -

Starting Funds Starting Funds 

Remaining - Remaining -

§ Gold 
Keys

Plat 
Keys

Sim 
Cash

Green Valley Region § Simcash (Possible Future Use) Region § Simcash

Small Weeping Willow Forest - Small Forest -

Starting Funds Weeping Willow Forest - Large Forest -

Grand Totals for All Specializations - - - - Contemporary Art Museum - Education -

Remaining Funds - - - - Bicycle Rental - Transportation -

Hoverboard Terminal - Entertainment -

Pet Park - Gambling -

Upgrades (manual entry) Upgrades (manual entry)

Total - Total -

Starting Funds Starting Funds 

Remaining - Remaining -

*The Regional Totals section is a summary that auto-fills from the values entered in each Specialization above; except 
for Upgrades, which must be entered manually.

Notes:
This is a full list of all "regular" Specialization plots currently available (January 2023). There are a lot of limited-time plots listed on here, but there are hundreds that are not. 

Some blank lines are left intentionally in the middle of some lists. They will still calculate if values are entered.

Adding Rows: all formulas are relative and will change to accommodate if lines are added in the main body of the sheet. However, the new rows will be missing formulas. Excel and Google Sheets- simply click on the existing cell above the new row, then click 
and drag the bottom-right corner of that cell down to automatically fill in the formulas below (or vice versa if adding the new row above). Apple Numbers- you should not need to do anything, the sheet should do all this on its own, but the same concept applies.

  Black Friday: This has been true in at least 2021 and 2022, not guaranteed to be so in future. During the Black Friday event week, there is an Event Track that requires spending actual money in order to earn the necessary points. 
Having Regions allows you to buy Piggy Banks (currently $2.99 USD, each) by completing exports at the Regional Export HQ. This method allows you to achieve the necessary points at a much lower cost than buying Simcash in the 
store or buying building offers. It simultaneously gives you a lot of Regional Simoleons that can be used during the Black Friday 50% off sale to obtain small Regional trees and Hot Spots. Even for those that try to avoid spending 
money, this is the best time of any to do so (other than Mayor's Pass). If you were to complete at least 9 export rows to buy all 3 Piggy Banks in a Region, you would obtain 14,000 Regional Simoleons (3 rows-2000, 6 rows- 4000, 9 
rows-8000). That would potentially be 112 small Regional trees during the sale, or a lot of trees and several Hot Spots. There are no other chances during the year to get this good of an opportunity on Region specific Landscapes & Hot 
Spots.

  Black Friday: if you plan to obtain large amounts of Landscapes and Parks during this event, it helps to expand more space in your Capital or Region and also use a Design Challenge map to temporarily store items while you are increasing your inventory, as 
you cannot add new items while there are still some of that same item in storage. 

Regional Trees and Hot Spots are placed at the end their particular sections to allow additions and alterations to lists without affecting formulas.

Tree Notes:

> Weeping Willow Forests (Green Valley), Cypress Forests and Coconut Tree Forests can keep much of their green color in the snowy sections of Frosty Fjords, whereas others will be mostly covered by snow.

Original Row and Column Sizes:

All Rows height- 25

Individual Column widths noted on line below:

22 175 38 38 67 40 40 40 71 48 48 53 60 22 175 38 38 67 40 40 40 68 45 45 50 60 22 10

Mayor's Pass Mayor's Pass
Optional use. Optional use.



Intro:
  Opinions expressed on this guide are the author's and not necessarily shared by others. Most information here is to assist newer players. All information and observations are from the US 
version of game, there will be minor differences by region. Much effort was made to avoid technical errors or otherwise find and correct them, but it is not necessarily error free. However, the 
guide is completely open to be edited for your own use. I request that you not claim this work as your own.

  SimCity Buildit is meant to be played over a long period of time, at whatever pace you choose. Progression is very slow at the start and gets faster as you go. You cannot expect to be able to 
accomplish everything in a short amount of time.

  Connecting the game to an outside account to Login (in Settings screen) allows you to recover your city when: you move to a new device, if your device is lost/damaged, if you want to play 
the same city on multiple devices and when you need to clear some storage from a device. This is the easiest step you can take to prevent unneeded frustration. I cannot comment on all 
Login accounts, but have noticed the most common questions seem to arise out of using Facebook, one of the reasons being because an account can be closed with no input from the user. 
Your game data is stored on the server and reconciled with your device when you connect with the server (using Trade HQ, participating in events, etc). Your game data is tied to your Player 
ID, which is good to note somewhere (in Settings>Help), but the outside account is what claims that Player ID and data as being yours. Many people that have chosen not to do so have lost 
their cities and it is a frequent help question on forums. Also change your city name, as the server generates a generic name for you and they are recycled and reused. 

   Over time, the game can start to become very sluggish and laggy upon opening. This usually seems due to the amount of unneeded data the app is storing. Presuming you have connected 
the game to an outside account; you can delete the app, reinstall and complete 1 or 2 steps of the tutorial, at which point the settings become available and you can download your city from 
the server in the Logins area. From personal experience, the app was using 5-6GB at one point. After a fresh install, the app was only using about 600-700 MB and was running smoothly 
again. The numbers just mentioned are not  guideposts, as a game with a full Capital and several Regions filled up will need more space than a half-filled Capital with no Regions.

Notes & Opinions:

  Consideration was given to linking certain cell information between the Multi-Purpose Production Calculator and the Income Comparison Calculator, but the potential for problems made it 
less than desirable. As such, the sheets can be fully edited without one affecting the other. There are instructions provided on the Income sheet if a user desires to make it so.

  You do not need to build a shop as soon as it is unlocked. Once you do, its items will be required for everything else you do. This same concept will apply to Regions later in the game. You 
will be able to buy the occasional items of unbuilt shops from the Global Trade HQ until you reach a point that you feel it will be easier to just produce them yourself or can more easily afford to 
build the shop.

  After building new shops, it is normal for your Global Trade HQ to be flooded with that shop's items. This is temporary and will balance back out after a bit of time. This same effect will apply 
to Regions later in the game.

  All shops are listed in the order they are unlocked. It is suggested to skip the Fast Food Restaurant and build the Home Appliances shop 1st, then delay the Fast Food until it feels as though 
it's harder by not having it. Fast Food's items require time consuming materials from other shops. Once you open it, its items will be requested for everything else.

Make sure your shops and factories are always producing something both in-game and before closing the game.

Making use of timers/reminders on your device is an easy way to avoid failing Contest of Mayors tasks and Epic Projects and to produce items while away.

  As a general rule, the more of a particular item you have in your inventory, the more likely you will see it appear in the Global Trade HQ. The less of a particular item you have, the less likely 
you will see it appear. For example, if you are about to use all 15 Chemicals you have, it is easier to get more from the Trade HQ before you use them (if space allows), as they will be harder 
to find afterward when you have none.

  The most beneficial way that you will ever spend Simcash will be on opening more production slots (11 total) in your Commercial zones and also slots on your Trade Depot (32 total). 
Prioritize Commercial slots, open more Trade slots as needed.

Do not ignore "Daniel's City" (US name), it refreshes every 24 hours. There are occasionally Storage and Expansion items there. Sometimes there is also the 1 last item you need to finish a task.

  Your city's only "NEEDS" are Services: Fire/Police/Health/Utilities (Drone Bases and Control Nets for Omegas). Specializations are only desires, no matter how much the residents request 
them. Your simoleons are always better prioritized on factories before Specializations.

  Roads- you can avoid spending simoleons on road upgrades until further into the game, as you will be constantly re-organizing your city. When the (!) appears urging you to upgrade, juggle the 
buildings around by picking them up and setting them back into place. More often, you will need to momentarily set them on a different street and can promptly put them back. Start with the largest building on 
the street. Sometimes you may need to momentarily move 2 or 3 of them. Another option is to add extra intersections and roads, but that reduces your space unnecessarily. Another option, if you have extra 
space, is to "trap" the (!) upgrade request on utility roads that do not have residential buildings on them. If a utility road gets the prompt, do not juggle those buildings and let the request stay there. It does not 
completely prevent requests from appearing on Residential roads, but can reduce the occurrence.

  Using Gold Keys and Platinum Keys on Specialization buildings that do not provide a minimum of 3 Epic points is wasteful until you are further into the game (a few 1 & 2 point buildings are 
required to be opened first). 1 and 2 point buildings are the biggest hurdle to completing Epic Projects. Storage is manageable, low points waste a lot of time and inventory.

  Feeder Cities & Camping- these are optional strategies employed by some as an alternate way to build storage and resources. They are not necessary to advance through the game, but are 
a personal choice as to whether you want to spend the extra time doing so. You can search guides or forums if you want to inquire more.



  Maxis Manors vs. Vu's Random Generator- I personally found Vu's Random Generator (with max slots) to be more valuable than 2 Maxis Manors, but others might prefer the Manors over the 
Generator. Another personal choice to be made depending how you intend to play. If you intend to play for a long time, then it is not so much of a choice between each other, but I would still 
get the Random Generator first. The Manors are more convenience, in my opinion, whereas the Generator provides constant benefit for several uses.

  Design Challenge is a very useful event to participate in, as it offers rare, Limited-Time buildings; storage, expansions, Simcash and other items. To a player that has never entered Design 
Challenge, it may seem like something that is only for creatives or a drain on time, but I regretted not participating in it sooner. Give it a try as soon as it is available. It is also highly useful 
during Black Friday week as an extra place to hold items while you increase your inventory.

  Black Friday- When you see cities full of trees, rivers, lakes, parks and large multiples of other plots/buildings; this is how people stocked up on most of them. Go into Black Friday week with 
a plan and you can maximize your haul and total savings. This is the primary purpose of that calculator (in addition to being an inventory for collections geeks).

Storage:*
The primary ways to obtain more storage are the Global Trade HQ, Design Challenges, Event Tracks, Mayor's Pass, NeoMall, Clubs, Daniel's City or popping bubbles.

  > Global Trade HQ: (the most common way to get most storage at low levels) go through other peoples' Trade Depots at random to find storage items. DO NOT wait for them to appear on 
the Global Trade HQ screen. Many people, especially at higher levels, do not spend the time to advertise storage items as they use that time to advertise items they want to get out of their 
inventory. Make sure you also pop the item bubbles on those cities as you check the depots. (This also applies to Expansion items)

  > Design Challenge: every Design season contains Storage items, Simcash, Expansion items, War Simoleons, Limited-time plots/buildings, Golden Keys & Platinum Keys. Earned Blueprints 
do not carry over to the following season, use them while you can.

  > Event Tracks & Mayor's Pass: not all Event Track weeks will have storage, all Mayor's Pass seasons will have storage.

  > Clubs: everyone is hungry for storage, even at mid-to-late levels. Do not expect that a club is going to shower you with storage if you join.

  > "Daniel's City" (US version)- there are free items here during every 24-hour period, occasionally there will be a storage or expansion item.

  All Regions contain a +20 storage boost. However, do not allow the desire for more storage to affect your decision to open a Region . See notes under Regional Shops** on Production 
Calculator.

  Only permanent increases to Capital storage count toward Contest of Mayors tasks. Permanent Regional & Omega storage increases and temporary storage boosts in Mayor's Pass & Vu 
Pass do not count toward Contest of Mayors tasks (currently).

* (2023) Some players have reported having regular access to a 2nd Cargo Ship for deliveries that can provide Storage items as rewards. It is unknown if this applies to all new cities, only 
certain levels, if it will be implemented everywhere or is just experimental/temporary.

Expansions:
  Expansions are saved and used by many for completing Contest of Mayor's tasks. Currently (January 2023), if you complete all expansions of a particular type before you have opened a 
Region that also contains those expansions, the tasks will no longer appear once you do open those Regions. Be cautious of how many you have left. Example: you fully expand your Capital 
mountains before opening Frosty Fjords, mountain expansion tasks will no longer appear during Contest of Mayors when you finally do open Frosty Fjords. Same applies to Land and Beach.

  Expansion vouchers obtained from Contest of Mayors stack/carry over from season to season. However, if you start to build them up, those particular expansion tasks may stop showing up 
in your tasks list. The same also applies if you have more than enough of a particular expansion's items in your inventory.

The notes for gaining Storage also apply to Expansion items.

Vu's Random Generator (Randomizer in other regions):
  Vu's Random Generator will randomly mimic one of your existing shops every 24hrs. It does not need to be upgraded, it will mimic the shop's level. However, its production slots cost 10x 
more than regular shops. 

  The 24hr clock is started based on when you first build Vu's Generator and it opens. The clock currently cannot be altered. When I first built the Generator, it did not open immediately and 
instead took a period of time (maybe 15-45 minutes, cannot remember) before finally opening, which is when the 24 hour clock started. Take care to consider this ahead of time. Try to consult 
a forum for people that have recently done so to see their experience.

  Vu's Generator is very expensive, but very valuable and worth the Simcash for long-term players. It is very useful for Contest of Mayors, Epic Projects, Design Challenges and as an extra 
source of income. I personally valued it more than having a couple of Maxis Manors.
Costs: Build- 2,000 Simcash;   All slots opened- 2880   =   Total 4880 Simcash.

Epic Projects
  Newer players- Projects are best attempted outside of Events. As you advance, you will find that you will be able to complete them during Contest of Mayors. Be aware that finished Epic 
buildings will have a random color scheme.

  When starting, it is best to have multiples of as many items as you can in your inventory. Diversity is better than total numbers; meaning if your inventory only allows for 2 or 3 of each, that is 
more ideal than 5+ of fewer items.



  When starting, it is best to have multiples of as many items as you can in your inventory. Diversity is better than total numbers; meaning if your inventory only allows for 2 or 3 of each, that is 
more ideal than 5+ of fewer items.

  1 & 2 point buildings are almost completely dead weight for new players that want anything more than Bronze. Take them off the map before starting the Project. If you forget, you can 
remove them while they refresh after completing a task. They waste both inventory and time during a Project. It is better to use your Gold Keys, Platinum Keys and Simoleons for buildings that 
provide a minimum of 3 points. Later in the game, they actually have use for being low points so as not to score too much, but that is not to be concerned about until then.

35 of each Speedup is the collection limit from your Epics. You can still keep collecting the speed-up rewards far beyond that limit. There does not seem to be any maximum total.

  The Silver (4x) Speedups are the most ideal to have for your everyday use. Gold (12x) Speedups are obviously very useful, but for fewer reasons and are prone to waste. As you gain more 
completed Epic Projects for a particular type of Speedup, more of those tokens will be required to complete a full Speedup. To illustrate the author's opinion of having Silver Speedups, these 
are the total Epic Buildings owned when writing this workbook:  Bronze- 9, Silver- 93, Gold 17.

  A few times a year there are Double Epic points events. They only count for the specific Specialization stated; any other will give normal points and be a wasted opportunity. Since the event 
lasts for several days, you can potentially obtain several gold Epics, as the cooldown/wait time after a fully completed Epic is 12 hours.

To a newer player, completing Epics seems absurd and daunting. However, there comes a time when one can easily earn the 100 points for a Silver Epic in less than 10 minutes.

Omega

  NeoBank- see notes on Production Calculator. The NeoBank only limits what you can collect from your Omega buildings. You can still collect far past that in rewards and demolitions. As an example of 
breaking past your NeoBank limit: as of this writing, my NeoBank limit is only §40,000. But if I were to demolish the 44 Omega Bridges and 8 Luxury Beach Houses I have on reserve, I could generate §400,
000 Neosimoleons.

  Omega Storage- it's necessary to increase your NeoBank limit, but as noted above, the need becomes less. It becomes much more favorable using the Omega items toward increasing the Omega Storage limit. 
Later in the game, you can set Omega residences, upgrade them once and demolish to quickly earn pink Event points needed for Event Tracks.

City offers for Omega items stop when your inventory is below 60% of your current capacity.

Random Bits:

Full 24-hour cycle: 10mins    Night lights: approximately 2mins 30secs

Construction animations:   Blue= tiers 1-4;    Dark Purple / Black= tiers 5,6   (colors will vary slightly depending on device)

Useful Links:
  The following links are NOT my own work, but are very helpful resources that other people have created over the course of years. You should take full advantage of them to aid you. Also, 
these are all fan created material and may not always be available; best to make use of them while you can.

Reddit Index of Guides/Wiki Page

A collection of charts, pictures, guides and information. Very useful to everyone from beginners to experienced players.

PDF Guides

Google Docs version of Index, may have items/links that differ slightly from Reddit Index.

Limited-Time Buildings List
A comprehensive spreadsheet with data, links to day/night pictures, release dates and more of rare plots & buildings for all Specializations. This sheet is very useful and informative.

Building Archive

A quick way to see information for current plots & buildings that are rewards or on offer. Very helpful to determine if you want to put time toward certain rewards.

Capital Expansion Map (updated December 2022)

Epic Buildings Poster

Regional Expansion Maps

NeoBank Increase Requirements

Omega Storage Increase Requirements

Buildings with Increasing Costs

https://www.reddit.com/r/SCBuildIt/wiki/index/
https://docs.google.com/spreadsheets/d/1Gc_lyGtFxc_bBVvAFIvzS6DOb2I7puYbZdlX6J9dvjo/edit#gid=1304361005
https://docs.google.com/spreadsheets/d/1NWXgGdMPiBxq7fY-XQmYaW0hMU6XRTwN/htmlview
https://www.reddit.com/r/SCBI_Buildings/
https://www.reddit.com/media?url=https://i.redd.it/ib737q34234a1.jpg&rdt=39020
https://imgur.com/kssqTPI
https://imgur.com/a/dPnUS4l
https://imgur.com/I6iAliF
https://imgur.com/KWfxiCp
https://i.redd.it/jyol8oo5wb291.jpg


Chart that shows progressive costs of Fire/Police/Health, Regional and Omega buildings.

Vu Tower Vu Tower
Easy to read guides for upgrading Vu Tower. Just as with anything else, you cannot undo an upgrade. Take consideration of how easy or hard it is for you to obtain and store Vu items before 
upgrading. 1 extra item to launch may not seem like much at first, but a Contest of Mayors that happens to be full of related tasks can quickly use up your supply just due to the 1 extra item 
needed to launch.

Active sub/Reddit Forum for SimCity Buildit 

Fandom SimCity BuildIt Wiki

Sometimes current, sometimes not. But, still filled with a lot of helpful information.

SimCity Buildit Discord

(if Discord link expires, use Reddit link to find updated invite link)

Afterthoughts:
  Everyone chooses to play SimCity Buildit in a different manner which can have large differences on choices to be made. These preferences color the advice and opinions reflected here by 
myself and elsewhere by others and should be taken into account when seeking advice and information. So as to make understandable what colors the above opinions and choices, I am 
noting how I chose to play to aid you in making your own decisions.

  Clubs- I had no desire to join any clubs from the outset. Having come from another game that revolved around alliances, I wanted to play at my own pace and time without obligations to others. The only club I 
was in was my own that I formed for extra Contest of Mayors rewards, nothing more. As such, I did not need the extra space that would have been required for Club Wars. On a related note, I kept minimal 
numbers of War items for attacking Vu's Monster for Contest of Mayors, but not many, as War Delivery tasks were more common in the past and the needed War Items could be obtained doing Deliveries or 
bought with War Simoleons.

  Feeder Cities & Camping- I did not use either of these strategies. However, when my city was new, I would spend many game sessions doing nothing but producing items for sale while proactively searching 
through other peoples' Trade Depots for storage and popping bubbles in their cities. It was boring, but I had podcasts and audiobooks to busy my mind.

  Contest of Mayors- I competed for most of 2022, but for most of that time, the Contest was using the Streak system. The Streak system was harder for casual players to earn Season points, as Streak bonuses 
could be foiled by an undesirable or impossible task, but made Contests easier to gauge your standing amongst those competing. The Milestone system made it easier for casual players to be able to earn Season 
points, but allows for more uncertainty for those competing. I routinely purchased Premium+ Passes. This was my primary event focus as I was not doing any Club Wars.

  Regions- I did not open any Regions until somewhere near level 55. The reasoning was that it would make competing in Contest of Mayors easier, which I feel it did. It also made my storage needs smaller. I 
ignored advice and opened Frosty Fjords first because of the trees. It is harder at first, but once opening a second Region, it didn't matter. I did not regret it. Cactus Canyon is a popular first choice, as the layout 
makes it easier to work toward more regions or make Omega farms. I left it for last, as the trees were the least desirable to me. The order I opened Regions was just a matter of wanting access to the particular 
trees.

  Design Challenge- Design is the sister competition to Contest of Mayors due to all the rare plots/buildings you can get plus Simcash and items. It is best to enter and try it out when it first 
becomes available. I did not enter until close to the same time as opening Regions, perhaps level 40-50. The reasoning was for time and I didn't want it to interfere with Contest of Mayors. 
That was a bad choice and I regretted it. You do not need to invest large amounts of time to gather some of the rewards such as Simcash and rare buildings; merely just enough to get the 
bonus points in each Design round. There are no downsides to entering the Challenge as there are with other game features.

  Epic Projects- At first, Epics seemed to be a daunting task after doing my first one for Bronze and thought Silver was going to be out of my grasp. On my 3rd attempt, I aimed for Silver and it showed that 
reaching 100 points was easier than I expected (although still hard at the time). You just need to have good starting inventory, disposable Simoleons to help you along and put 1 & 2 point buildings in storage. I 
started by doing them during the "off days" from Contest of Mayors and the "off week" between Mayor's Pass Seasons. Not long after, I started doing them during Contest of Mayors. Vu's Random Generator can 
make a very big difference. 

  Vu Tower- There is a wide variance of preference on the Tower. I stopped upgrading it at level 4 as it personally allowed a good balance for completing many combinations of Launch Disasters tasks, Repair 
Disasters tasks and Gold Key tasks in Contest of Mayors, while also not demanding too many extra Vu Items to launch.

  Simcash- I prioritized Simcash on expanding all Commercial slots and Trade Depot slots. I ignored Maxis Manors and obtained Vu's Random Generator and expanded all slots as my intentions were for 
Contest of Mayors and Epic Projects. I later obtained 1 Manor with Simcash and obtained a second during a Black Friday week event as a reward. I refuse to pay the doubling costs for them, but that is my 
personal preference. I resisted nearly ALL urges to use Simcash for shortcuts. Some of the exceptions were times that I needed one last Storage item to upgrade or one expansion item. Not every time, just 
sometimes. The rest I saved for Black Friday.

  Gold Keys/Platinum Keys- Early on, I only used my Keys for plots/buildings that gave a minimum of 3 Epic points (they usually require some 1 & 2 point buildings to be built first). I saved the rest for Black 
Friday (although there were some exceptions for Limited-Time buildings). Later in the game, it becomes easier to spend Keys on low point buildings purely for aesthetics.

  This Workbook- After about 1 year, I decided I was done competing in Contest of Mayors and starting thinking about how to get the most out of Black Friday. The Black Friday sheet was the first spreadsheet 
I made for the game, although it was very basic. The rest of the workbook was born out of that calculator. The result is spreadsheets I wish I’d have made for my own use, but never set aside time to make. 
Hopefully, it will be useful for both new and old players.

Other:
> Why didn’t you use "X" formatting to allow "X"?

Because the sheets need to be editable by the most amount of people. The more formatting put into the sheets reduces that number.

> The row and column sizes noted at the bottom of each sheet are not important to the function of the sheets. They were necessary for the perpetual editing and tweaking being done to match 
across 3 platforms. I saw no harm leaving the information there for the end-user. It can be deleted if one pleases.

https://simcity-buildit.fandom.com/wiki/Vu_Tower
https://imgur.com/CZnNhU4
https://www.reddit.com/r/SCBuildIt/
https://simcity-buildit.fandom.com/wiki/SimCity_BuildIt_Wiki
https://discord.com/invite/zXmMPkp


> The row and column sizes noted at the bottom of each sheet are not important to the function of the sheets. They were necessary for the perpetual editing and tweaking being done to match 
across 3 platforms. I saw no harm leaving the information there for the end-user. It can be deleted if one pleases.



How To Use This Workbook:
This workbook is completely open to the public, fully editable and not closed off with any passwords or special permissions. As such, I would kindly ask that you not represent any of the original work as 
your own. I have no issue with (and even encourage) the workbook being translated into other languages if you are multi-lingual, but cannot control any errors caused doing so.

All 3 versions are the same. All are meant to be used on a computer or tablet with keyboard and arrow keys. Phones also work, but with slower efficiency due to lack of keyboard and the much smaller 
screens may cause a bit of eye fatigue. On initial testing, Google Sheets appeared to be ok on Mobile, but before release, it had started to show considerable lag when typing. 

Open in Google Sheets
(You will need a Google account to open & use this version. It can be a bogus account, it does not matter.)

1)  Click link

2)  When the Spreadsheet Workbook window opens, you will see a green box with an eye that says View Only.

3)  Right above the View Only box (NOT your browser menu), click File, then Make A Copy. *Do not try to use the Download and convert to other format option, it may not retain formulas and proper 
formatting.

4)  A complete copy of the Spreadsheet Workbook will be made on your Google Drive.

5)  There will be one entry on your Google Drive titled “SimCity Buildit Big Production, Design & Inventory Calculator” with owner “(name other than yours)”; there will be another entry titled “Copy of 
SimCity Buildit Big Production, Design & Inventory Calculator” with owner “me”. You can then rename it however you’d like.

6)  Before editing, you should delete/remove the original and make your own clean backup copy of the copy just made on Step 5). Keeping the original as the backup copy is inadvisable as it 
is a web document and any changes/accidental deletions made on the source original would change all web versions of the original. Your copies are yours alone and unaffected by such 
issues.

7)  If you are using it on a laptop/desktop, you can open it immediately. If you are on a mobile device, you may be prompted to download the Google Sheets app to use it. Inside the app, you can click the 
Options (•••) button in the upper right corner of screen of the app, then select Available Offline from menu.

Open in Microsoft Excel
1)  Click link

2)  Open download

3)  When Spreadsheet Workbook opens, workbook may say Read-Only at top by document title.

4)  Go to File>Save As…> then rename and choose location to save it in.

5)  Before you begin to edit the workbook, it is advisable to make a backup copy so that you do not need to repeat the process or the original becomes unavailable.

Open in Apple Numbers
1)  Click link

2)  Open download

3)  When Spreadsheet Workbook opens, click on the sheet title, rename and choose location to save it in. The default save location will likely either be Downloads or iCloud.

4)  Before you begin to edit the workbook, it is advisable to make a backup copy so that you do not need to repeat the process or the original becomes unavailable.

Desktop (optional)- disable predictive text: go to Numbers drop down menu>Preferences>General Tab>Editing “Show suggestions when editing table cells”                                                                                                                        

iOS (optional)- disable predictive text: go to Settings (•••)>Auto-Correction>Turn off "Show Suggestions When Editing Cells".

Locked/Protected Sheets & Cells To Avoid Accidental Changes:
Do not be discouraged by all the notes below, they are just here to aid those that are unfamiliar with any of these spreadsheets.

Google Sheets
  The Production Calculator, Design Challenge & Inventory/Black Friday sheets are Protected to guard most cells against accidental changes to formulas and permanent data. The cells that the user 
needs to input quantities, adjust times or enter information into blank cells are already excepted from Protection. The Protected or Unprotected status of a sheet can be determined by the Lock icon on the 
individual tabs. If an entry is made in a Protected location, a warning window will pop-up before the change is made.

> Protect entire sheet in general: right-click sheet tab>Protect Sheet>window pane will open on right>Set permissions>Show a warning when editing this range.

> Specify cells/ranges to be exempt from Protection-  right-click sheet tab or select Data from Menu Bar>Protect Sheets and Ranges. Window pane will open on right. If pane opens with a box that says 
Permissions, click Cancel next to it. The pane should then list the sheet and # of excepted ranges. Click “Show All Protected Ranges” below. All sheets should then be listed showing the # of excepted 
ranges. Click on the desired sheet. The sheet will open and the window pane on the right will show a detailed list of all the excepted ranges (if any have been set). There will also be a trash can icon in the 
upper right corner of the pane. Excepted cells/ranges are those that are exempt from Protection. Here you can start to add the cells/ranges that you want to except.

> Remove all Protection or certain Exceptions- follow steps directly above. Click the trash icon to remove all Protection or click the individual “x” to remove only certain exceptions.

> NOTE: When right-clicking the page tab, there are options to Duplicate or Copy To New/Existing. These options will not copy over Protection/Exception settings to the new sheet. Protection/Exception 
settings can only be copied by making a full copy of the workbook under File>Make A Copy.

Microsoft Excel
  The Production Calculator, Design Challenge & Inventory/Black Friday sheets are Protected to guard most cells against accidental changes to formulas and permanent data. The cells that the user 
needs to input quantities, adjust times or enter information into blank cells are already Unlocked. The Protected or Unprotected status of a sheet can be determined by right-clicking the individual tabs 
(PC) or the Lock icon on tabs (Mac).



> Protected status means only cells formatted as Unlocked can be typed into, the rest (Locked) are Protected. Be aware that Protected status is to prevent unintended data entry; unintentional formatting 
changes can still be made. This is the preferable status to use the sheets.

> Unprotected status means any cell can be altered, regardless of being formatted as Locked or Unlocked. Be careful in this status. If you are Unlocking to make changes other than quantities or times, 
make a copy 1st.

> Protect/Unprotect Sheets: right-click the sheet's Title/Name tab and select either Protect sheet or Unprotect Sheet. This can also be found under the Review tab in the Ribbon.  

> Lock/Unlock specific cells/ranges: select cell or range> right-click> Format Cells…>window will open> select Protection tab, check or uncheck "Locked" box.

> When making copies of sheets, all Protection and Locked/Unlocked settings will be also copied.

Note for Mobile: workbooks cannot currently be Unlocked for full editing purposes on mobile, Unlocking and full editing must be done on a computer.

Apple Numbers
  The Apple Numbers version does not have any inherent cell Protection. The process for locking sets of cells, rows and/or columns in Numbers is a bit cumbersome and involves making separate tables 
for sets to be Locked or Unlocked. As such, I have not built the sheets in this way due to time.

> Lock/Unlock Sheet: click the Lock icons at the top of the window or right-click on the Circle (All/Multi-function) icon at top-left of sheet, select Lock. To Unlock, right-click anywhere on sheet, select 
Unlock.

> Lock/Unlock Workbook: entire workbook can be fully locked to guard against accidental changes when not in use. Click on Workbook's Title/Name at top of window, check box labeled Lock/Unlock. This 
applies to entire Workbook.

1-6) The following can be ignored by almost all users. An alternate way to achieve a degree of cell/range protection in Apple Numbers without making tables is as follows (but also time consuming):

1) Go to the Shapes menu at the top of the window, select square from Basic menu.

2) The square will appear as an opaque solid, drag it to the area that you want to cover to prevent changes and resize it to fit. Repeat for entire sheet.

3) After covering all desired areas, click a placed Shape; on the Formatting toolbar, go to the Style tab, go down to the Opacity slider and move it to 0%. This will make the Shape transparent and prevent 
clicking on the cells under it. The Shape’s outline will visible if clicked on.

4) Right-click it and select Lock to prevent the Shape from being adjusted.

5) If you need to remove the Shape, right-click it and select Cut.

6) This method only effectively serves to place a piece of glass over the cells you want to protect. Cells underneath it can’t be clicked on, but a cursor can be moved under it with arrow keys from a cell 
outside of its area, allowing the cells to be altered.

Hide Gridlines (Optional to make some sheets look cleaner; not recommended for Black Friday sheet)
Google Sheets:  on Sheet menu bar (not browser menu bar)>View>Show>Gridlines.

Microsoft Excel:  1) on Ribbon>View>Gridlines  2) Or, on Ribbon>Page Layout>Gridlines>select/unselect View box.

Apple Numbers:  on Formatting toolbar>Gridlines>select/unselect the horizontal and vertical grid boxes.

Notes:
Save a copy of this workbook to your device(s) so that you can keep all of the custom changes you make as needed. This workbook is fully editable and does not contain any passwords.

  The pre-filled production times and material requirements are all based on fully upgraded shops on a city started prior to mid-2022. Note that there are newer cities that have some variances in 
production times and material requirements. Simply change the appropriate values in the “Time (mins)” column and the “Req” columns to match your city and/or the current levels of your shops as 
needed, the other calculations will fill automatically. Max prices are the same regardless of upgrade level.

  All item names are listed as they appear in the English (US) version, with the exception of: Sugar and Spices= Spice, Fruit and Berries= Fruit, Electrical Components= Elec Comp, Recycled Fabric= 
Fabric. This is for Search purposes. If you change the names on here to suit your preferences, make sure to change all instances that they appear or the Search will not be useful.

These sheets are typed in Arial font. It is suggested you keep Arial as it easily transfers across operating systems/devices.

Column spacing is set to accommodate different sets of data on different areas of the sheets. Making columns narrower may result in some of that information being blocked out.

Sheet Summary:
  Production Calculator - this sheet will calculate how much Simoleons items will be worth; how long they will take to produce at normal, 2x, 4x and 12x speeds; the required materials for each item; the 
total amount that each item can be mass produced at normal, 2x, 4x and 12x speeds; a mass production time reference; an Omega/Neosimoleon demolishing calculator and an assortment of other 
information. All you have to do is enter a quantity for a particular item and the sheet will do the rest. Exception: low to mid level users will need to manually adjust the build times (in minutes) to your 
current levels.

  Income Comparison / Simoleon Earning Calculator- meant for newer players, provides a comparison chart of actual time needed to produce products from beginning to end and the value of that time. 
Also, a calculator to compare the value of buying vs producing required materials.

  Design Challenge Calculator - this sheet is mostly meant for players new to Design Challenge, but some others may still find use for it laying out their Regions. It will calculate the Service Demands 
that will be required, the max population (without Specialization boosts) and also has a list of Service options with costs.



  Inventory / Black Friday Calculator - this sheet is a full list of all “regular” Specialization plots currently available (January 2023) including many limited-time plots with blank spaces for 
others to be added in the future. By entering the particular cost of any item and the amount you would like to obtain, it will calculate both individual and total costs for Simoleons, Golden Keys, 
Platinum Keys and Simcash in each Specialization.

Notes - assorted notes and opinions; a list of helpful links to other peoples' works.

Instructions - how to open & use the Workbook in different formats. Brief notes about using the Workbook.


